Sign up for Larry's FREE
Monthly Newsletter!

Enter your email

Editor: Larry Jordan
Issue #73 - Nov/Dec. 2010
Here's the latest edition of my FREE monthly Final Cut Studio Newsletter for
November/December, 2010. This is my FIRST issue for December. You can read the second
issue here.
The goal of this newsletter is to provide information helpful to the interested user
of Final Cut Studio. This newsletter publishes each month, past issues are
available in my store. All software references are to Final Cut Studio (3) unless
otherwise noted.
Please invite your friends to visit my website -- www.larryjordan.biz. There you'll
find daily tips, the latest industry news, and over 500 articles and tutorials to help
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WRAP-UP
WELCOME
Wow! Where did the time go?
I looked up and, suddenly, the end of the year is barreling down on me. Seems like I totally
missed November. Hope you had a great Thanksgiving?!
So, I'm hoping to do TWO newsletters between now and the end of the year to catch up. It
sounds good in theory, but we shall see...
Things are busy around here. Our on-line webinars are continuing to grow; though I'm
discovering it takes a lot of research to come up with new material each week. Our podcast,
the Digital Production Buzz, is now heard in 100 countries around the world! We've expanded
significantly into social media -- our YouTube Channel is taking off with over 10,000 views and
growing at about 10% a week -- as well as Twitter and Facebook.
In fact, later in this issue, I'm starting a new feature called "Facebook Conversations," which
presents a recent conversation with our readers on that site.
This month's issue features a variety of tutorials that I discovered while researching material
for my webinars. There are some very cool tricks here that I'm looking forward to sharing with
you.
Finally, this is the holiday season. A time to reconnect with friends and family. On behalf of all
of us here, I wish you the very best of the season. I love what I do, but what makes it truly
worthwhile is your feedback and support.
As Charles Dickens wrote in the Christmas Carol: "God bless us, everyone."
[ Go to Top. ]

ADD YOUR COMMENTS TO OUR YOUTUBE CHANNEL

Our YouTube Channel is up and cruising with over 50 training videos posted. We'd love to
hear from you.
Take a minute to visit our channel and add your comments.
I always enjoy hearing from you.
[ Go to Top. ]

TECHNIQUE: NAILING DOWN FINAL CUT PRO'S ANCHOR POINT
It's hidden in plain sight, near the top of the Motion tab in Final Cut Pro: Anchor Point. But,
what does it do?

FINDING YOUR CENTER
Before we jump into this, we need an essential bit of background. By default, Final Cut
calculates all its effects, moves, and positioning relative to the dead center of the Canvas or
Viewer. This is illustrated by the Center parameter (above) consisting of two boxes, each
containing "0".
The left "0" refers to the horizontal position of something, while the right "0" refers to the
vertical position of something. By default, Final Cut places the center of an image in the
center of the Canvas (or Viewer). This position is called the zero point; or, sometimes, the
0,0 point.
NOTE: Photoshop puts its 0,0 point in the top left corner of an image. FCP uses
dead center. It always needs to be somewhere, but it isn't necessarily the same
between applications.
The Center parameter determines where the center of an image is placed, relative to the
center of the window. When it is set to 0,0 the image is placed in the center of the Canvas (or
Viewer). Keep in mind that just because an object is at the center of the frame (0,0) does not
mean it is full size. Scale controls size, Center controls position.

We use Center to move an image away from the zero point. In the illustration above, to move
an image to the left, you enter a negative number in the left-hand box of the Center
parameter. To move the image right, you enter a positive number in the left-hand box. To
move an image up, enter a negative number in the right-hand box, and to move it down,
enter a positive number in the right-hand box.
Thus, negative numbers move an image up and left, while positive numbers move down and
right.
The blue dot in the upper left has a coordinate position of -100, -100. The blue dot in the
lower right has a coordinate position of 100, 100. Using this coordinate system for the Center
parameter, you can position an image anywhere in the Canvas (or Viewer).
NOTE: Because the zero point is in the center, you can place two objects
equally on either side of the zero point by simply changing the sign of a number.
This makes it very easy to create symmetrical layouts.
THROWING DOWN AN ANCHOR
What the Anchor Point setting allows us to do is to change where Final Cut places this zero
point for two other Motion tab parameters: Scale and Rotation.

For example, setting the Anchor Point to -100, -100 doesn't change how the image is
displayed. That's because the Anchor Point works in tandem with two other settings: Center
and Rotation. (Image courtesy of Pond5.com.)

Here's an example. Both the Center and Anchor Points are set to 0,0. I rotated the image 45º.
As you would expect, it rotates around the center of the image.

Now, I've moved the anchor point to -960,0 (this is a 1920 x 1080 HD clip), and see that the
image now rotates on its left edge. The anchor point determines the point around which
rotation occurs.

Here, I've changed the anchor point to 0,-540 and the image rotates on its top edge.
While the Anchor Point determines the point around which an image rotates, less obvious, but
still powerful, is that the Anchor Point also controls the point from which an image zooms.
Let me illustrate.

Here, I've scaled an image to 50%. As you would expect, it scales from the center of the
image.

Now, I've moved the Anchor Point to 960, 540 (the lower right corner) and notice where the
image scales from! (Correct, the lower right corner.)
Changing the anchor point is a great way to simplify animating zooms, because you can put
the anchor point on the spot you want to zoom into, or from, without having to keyframe the
Center parameter during the zoom.
Cool.
ANCHORING YOUR, UM, ANCHOR
Except, how do you move the anchor point? Entering the right numbers into the Anchor Point
setting can be overwhelming for the numerically challenged.
Is there no option? Can no one come to our rescue? Where's a superhero when we need
one??
Fortunately, we have one. Masquerading as a mild-mannered icon that absolutely nobody
understands, is the Distort tool. This tool has the power to move Anchor Points. Wow.
Here's how it works.

Select your clip in the Timeline.
From the top-right pop-up menu, change the setting to Image+Wireframe. The white X
highlights the selected clip. (Those with REALLY good eyesight will notice a small number just
above the center of the X. This is the number of the track the selected clip is located on.)

From the Tool palette, select the Distort tool. (Second from bottom, keyboard shortcut: D.)

Using the Distort tool, grab the small square in the center of the X and drag it. This is the
Anchor Point. Drag the Anchor Point where ever you want it. (In the example above, I turned
off the image to make the Anchor Point easier to see.)
Simple - and very fast. And who knew the Distort tool had such power lurking under the
surface?
Equally cool.
Webinar Note: Have you ever wondered if you knew as much as you should
about the Motion tab in Final Cut? Well, here's your chance to learn more. I've
created a webinar titled: Secrets of the Motion Tab: Making Things Move in
Final Cut Pro. This one-hour tutorial walks you through everything you need to
know to make the Motion tab create magic for you.
[ Go to Top. ]

SPECIAL OFFER:

BUY ONE WEBINAR, GET "GROW YOUR BUSINESS" FREE
Thinking of my on-line training, reminds me that we have a special offer from now 'til
Christmas.
Buy any of my webinars and get "Grow Your Business" FREE.
This year has been a hard one for many of us. Clients have disappeared, jobs have vanished,
and budgets are in the tank. I wanted to do something to help. So, I created a webinar
devoted to helping us find and keep clients.
This is also the reason I created the Buzz Shout-out! A chance for you to showcase your best
work and attract clients to your site. More on this in a bit.
As a thank you for your support during this last year, I'm offering this title free when you buy
any other title. This is a $35 value.
Here's a list of all our webinars. Purchase the ones that interest you. And, by separate email,
we will send you the download link for your FREE copy of Grow Your Business.
Happy Holidays from Us!
[ Go to Top. ]

TECHNIQUE: CREATE A REFLECTION IN MOTION
OK, I confess. Motion has intimidated the heck out of me for a long time. I avoided using it as
much as possible. I read the books, took the tests, but never liked the program.
However, recently, I reluctantly acknowledged that LiveType is not coming back. It was time to
make my peace with Motion.
Over the years, I've discovered that the best way to learn something is to teach it. So I spent
several weeks putting together my three Motion webinars, so that I could explain the software
in ways that both you and I could understand.
NOTE: If you need help learning the Motion interface, I strongly recommend you
view my webinar "Master Motion" which walks you through everything you need
to know.

One of the effects I wanted to create for my training was a reflection of a moving clip of video.
This is what we are going to create in this technique.
NOTE: Thanks to a quick note from Adam Sumner, I realized that this effect is
in Motion 4 only.
THE PROCESS
Create a new Motion project (File > New).

In this example, I'm using NTSC DV Anamorphic as my project preset. Just as you need to
tell FCP what video format you are using, you need to do the same thing for Motion. However,
the techniques in this article will work for any video format you select.
Reflections require two things:
A source object
An object for the source to reflect upon.

Since we generally use black surfaces for reflections, we need to change the background color
of Motion from Black to Transparent so we can see what we are doing. You change this
using the Color pop-up menu in the top-right corner of the Motion Canvas window.
To keep this technique simple, I'm just going to create two objects: a source and a surface.
The source is a colorful video clip. The reflecting surface is what we are going to create now.
1. If you are playing your project, stop playback.
2. Position your playhead at the beginning of this project (press Home).

3. In the Motion toolbar in the top left corner of the Canvas, click the Rectangle tool located
in the Create group. (I've found that creating reflections is easier if you create the background
first, then add the source objects.)

4. Draw a rectangle so that it fills most of the Canvas. The exact size is not important.

5. Reflections can only be added in 3D space. Which means we need to switch Motion from
2D to 3D. To do this, press F5 to display the Layers pane.
6. Then, on the right side of Group bin are three gray shapes, laid side-by-side. Click them so
they are stacked on top of each other. This converts the Group bin from 2D to 3D space.
If you look very, very carefully at the Canvas you'll see that absolutely nothing has changed.
This is because Motion does all its calculating in 3D space, even if you are working in 2D.
This means that changing this setting won't change any of your objects in the Canvas.

7. Go back to the Toolbar, at the top, and click the Adjust 3D Transform tool (shortcut: Q).
8. If the rectangle is not selected in the Layers pane, please select it.

Inside the image of the rectangle, in the Canvas, three white circles, a green arrow, a red
arrow, and a blue dot now appear. These allow us to move and rotate an object in three
dimensions:
Red = Horizontal
Green = Vertical
Blue = Depth
NOTE: Think R/G/B - Horizontal/Vertical/Depth. Clever, these programmers.

9. Click in the top circle and a red line appears, which allows you to rotate the rectangle back
in depth. (You can experiment with other circles in this control, but the red one is all we need
to change.)
Rotate Red back until its about -54 degrees. Don't worry if this isn't perfect, there is plenty of
time to adjust this later. Notice how the edges of the black rectangle no longer fill the frame.
We will constantly be adjusting the size of the rectangle during this exercise so by the end it
does fill the frame.

10. Because the rectangle stretches back into space it no longer fills the frame. Hold the
OPTION key and grab either of the top two corners and stretch the rectangle until it fills the
entire frame with black.
NOTE: Holding the Option key adjusts both sides at the same time.

11. Click the File Browser tab (in the extreme top left corner) to display your hard disks and
file system. Using the Browser in the lower half of this window, find a video clip you want to
use as your source image.
12. Select it to load it into the Preview window at the top. Click Import to load it into the
Canvas.
NOTE: When the playhead is not playing, new objects are placed at the position

of the playhead. If the playhead IS playing, objects start at the beginning of the
project.

13. Hold SHIFT and OPTION, then drag any control dot that you see to scale the image
smaller. Shift constrains the aspect ratio, while Option scales the image from the center. Make
it whatever size you want, but for this, make it small enough to fit in the upper portion of the
frame.
If you are like me, the black rectangle slices that image somewhere near the middle.

14. So, select the rectangle by clicking it and drag it lower in the frame. You want to see the
entire video image of your clip.

15. If portions of your background appear around the edges of the black rectangle (this is the
reason we switched the background display to transparent back at the beginning of this

exercise), grab the edges of the rectangle and resize it until it covers the frame and doesn't
block any of the video clip.

Now the cool part starts.
16. Select the rectangle, just in case it isn't selected. Click the Inspector tab (top left corner)

Click the Properties tab and turn ON Reflection.
Wowl!
Add a few points of Blur (I used 3), and turn ON Fall-off.

A very cool reflection effect!
Webinar Note: Has Motion baffled you? Well, I've created a three-part webinar
series to help overcome your fear of Motion. They are:

Master Motion: Even if Motion Graphics Scare You
Advanced Motion: Create a DVD Menu
Unlock the Power of 3D Space in Motion
This technique is a simpler version of an exercise in the Motion 3D title.
[ Go to Top. ]

OUR GIFT TO YOU -- A FREE WEBINAR!
To celebrate the holidays, we want to offer you a free gift - a free webinar called "Ask Larry
Anything!"
Wednesday, Dec. 29, I am hosting three shows - 9 AM, 1 PM, and 5 PM Los Angeles Time.
We have only 100 seats for each event - so sign up today. This is totally free and we have
not yet decided if we will provide a downloadable version after the event or not.
Click here to learn more and register.
[ Go to Top. ]

TECHNIQUE:
CREATING TEXT WITH CAST SHADOWS USING TITLE 3D
Here's another technique that grew out of a recent webinar -- creating cast shadows using
Boris Title 3D. Title 3D is bundled with your version of Final Cut, so you already have this
installed on your system.
IMPORTANT NOTE: Boris Title 3D is not stable inside Final Cut Pro 7 unless
you have the latest version; which is free. Please watch this free demo with
instructions on how to find out what version you have and where to upgrade.
(The information you need starts about 1:20 in.)

Here's what we are going to create. An outlined, angled clip with a cast shadow. You can't

create this using Final Cut's Text tool.
NOTE: This demo should work with every version of Final Cut from about FCP 5
or later.
1. Start by adding a background image to track V1 in Final Cut Pro.

2. Click the Video tab in the Viewer and go to the lower right corner and click the Generator
button. (It has a small letter A on it.)
3. From this pop-up, select Boris > Title 3D.

4. Edit this clip so it is on the track above your background clip.
5. Double-click the clip to load it into the Viewer and click the Controls tab.

6. Double-click directly on the Title 3D tile to open up the text editor.

7. Enter the text for your title in the upper portion of this window. For my example, I'm using
"Buffalo".
8. In the lower portion of the window set the font and size of the text. In my example, I'm
using 96 point Cooper Black. Although you can, I'm not making any adjustments to any other
setting in this window.

9. Click Apply to accept your entry (lower right corner) and look at it in the Canvas. If the
position is wrong, DON'T move this clip in the Motion tab!

10. Instead, click the cross-hair next to Position X/Y, then, without clicking anywhere else,
click in the Canvas and drag your text clip where you want it to go.

11. Although this is optional, you can impress your friends by scrolling down a little farther in
the Viewer and adjust the Spin setting. Watch how this provides a 3D perspective to your text.
(Yeah, OK, go ahead and see what Tumble and Rotate do. I'll wait.....)
We now have our text positioned, rotated, and sized properly. Now to add the shadow.
12. Scroll up to the top of the Viewer and double-click the Title 3D tile in the Controls tab.

13. In the lower panel, far left side, are five tabs. Click the fourth one down. This allows you
to add edges and bevels to text.
14. Before you can apply any effects you need to select the text you want to apply it to. So,
select your text. (This image shows our text selected with the edge effect applied.)
15. Then, click the checkbox for the top box. By default it adds a plain back line around all
your text. Since all we want to do is define the edges of the characters a bit better, this is fine.
However, feel free to see some of the other choices available.
NOTE: Remember, you need to select your text before you can apply an effect.

16. To add a cast shadow, click the bottom tab on the left side.
17. Be sure your text is selected, then click the top checkbox, and change the popup menu to
Cast Shadow.

18. With your text still selected, adjust the shadow angle so it falls in the direction you want.
For my example, I set this to -36º.
Click the Apply button and admire your new effect.

Cool, again!
Webinar Note: I've created an hour-long webinar filled with how to create
fascinating effects using Title 3D. To learn more, click here.
[ Go to Top. ]

A FACEBOOK CONVERSATION
Recently, on our Facebook page, I started a conversation with readers when I asked: "The
industry is committed to tapeless video. What are your biggest challenges with it?"
Over 1,700 people read this and many responded. I thought you'd be interested in a summary
of what they had to say.
Noel McElligott Storage, damn hard drives break all the time!
Larry Jordan Noel, I've been writing and talking about storage for a long time. It
is even more important than the speed or RAM of your computer. Here's a
tutorial that explains more: http://tinyurl.com/2vup8d6
Daniel Jacobs Archive!
Caps H I [have to] check all the time for supporting files.
Michael J. Müller Backup and archive.
Larry Jordan Daniel, Michael, Brian, I agree that archiving is critical - and it's
easy to do IF you have a lot of money. It's figuring out how to do it safely and
cheaply that is the challenge today. I'll look into this further and see what I can
do.

Rick Jones Conversions. If only all formats could be edited natively. Getting closer but not
there yet.
Larry Jordan Rick, in spite of appearances, you don't WANT to edit all formats
natively. Many times there are too many trade-offs when editing a file in its
native format. H.264 is a classic example. So is MPEG-2. It is far better to
convert formats that take forever to render (HDV) into something that renders
much faster and with higher quality (ProRes). Here's a Tutorial I did that goes
into a lot more detail about this: http://tinyurl.com/3yjg93w
Neil Gregory [I agree with] what Rick said. When will FCP work with P2 raw files without
transcoding, please?
Brian Pshyk Larry, for me it is archive with non-client content.
Jim Burns I already own 7 devices that use tapes. There is no compelling reason for me to
move to a tapeless workflow. I'll try to hold out for as long as it makes sense.
Don Lewis Tapes, Tapes, Tapes. We all have so many of them. And what about storage
degeneration? How long can we store to tapeless media, or our external HDs, for that matter?
Ludwig Schramm backup and archive
Julie Smith Stoecker Fear of loosing my original footage. At least with a tape, I can recapture
it if the file gets lost or corrupted. I can't do that with tapeless. Space is also an issue,
affordable space that is.
Peter Neill In local TV news, keeping track of memory cards, which are substantially more
expensive than tape and compatibility issues - e.g. Quantel SqEdit doesn't recognize AVI files.
Matt O'Connor loss of raw footage - I've still got the very first mini dv tape I shot on (1996)
and it still plushest on a JVC GY-HM100U ("Apple Cam") in March 2010, files corrupted and I
lost the lotted the client.
Lance Ogren While sometimes it's nice to have the original raw footage on tape, I
occasionally spend too much time searching for an old clip that strikes my fancy..... and then
what about all the tapes I've got for the cameras I had to sell when I upgraded. It's a pain to
keep borrowing different decks, but I don't use the tapes enough to make buying a deck
worthwhile. Sometimes I wish I had all the raw footage already digitized and backed up on
hard drive. Wait, at least I've got easy access to all the Tapeless footage.
Johannes Schoutsen Simple, Archiving! I film on average about 140GB a weekend. This
material sits on the Drobo till they come into the pipeline for the edit. The time it takes from
Post to Delivery is a stressful time, for I do not have a hard copy (tape) of [my source media.]
Gerald Davenport Well, it's all been mentioned: archiving, conversions, storage space, and....
you know with new technology that fixes or makes some things more convenient it breaks the
bonds on others. Nothing is 100% prefect for everyone or every need.
Derrick Charleston Getting different software/computers to "talk" to the cards. Too many
CODECS. It's a "pissing" contest now. There needs to be a universal acceptance like mini DV
tape was so simple! It just WORKED!
Larry Jordan Derrick: I agree that simplification is ideal. However, it won't
happen in the near future, it will only get worse. Sigh...
Share in the conversation - visit our Facebook page and join in!
[ Go to Top. ]

SHOWCASE YOUR BEST WORK
ON THE DIGITAL PRODUCTION BUZZ!
It is no surprise to any of us that this is one of the toughest job
markets we've seen in a long time. And getting clients to find you is
really hard! So, the Digital Production Buzz is doing something to
help.
You can learn more here: www.BuzzShoutOut.com. So far, we've had
over 100,000 people visit this site.
Imagine putting your showcase here so more potential clients can
find you! You can, and it's FREE. Thanks to the support of our far-sighted sponsors for
making the Buzz Shout-out! possible.
If you want to expand the reach of your marketing and attract clients from around the world
and not spend a dime, this is for you!
We accept audio or video files, be sure to read the Guidelines before submitting.
Put the power, reach and audience of The Buzz to work for you -- showcase your best work
on the Digital Production Buzz Shout-out!
Click here to learn more.
[ Go to Top. ]

TECHNIQUE: CONVERTING AUDIO FILES FOR FINAL CUT PRO
This next tutorial came from a question that Derrick C. asked us on Facebook, but it has a
longer answer:
Why doesn't MP3 audio play nicely with Final Cut Pro? What audio formats do?
The answer is because Final Cut Pro was invented to support only uncompressed audio files.
There are only three audio formats that Final Cut supports: AIF (and AIFF), WAV (and
Broadcast WAV), and SDII. All compressed formats (like MP3 and AAC) need to be
converted into an uncompressed format before you can edit them.
You can do this conversion in Soundtrack Pro, QuickTime, Compressor, or lots of different
audio applications. Here's an old article that explains how to do this in earlier versions of
QuickTime.
In this technique, I'll show you how to do this more easily in Compressor. Apple's Compressor
allows us to easily convert a file from compressed to uncompressed. Here's how.
1. Open Compressor.

2. Drag the audio file you want to convert into the gray box with the downward pointing arrow.

3. Click the Settings tab (lower left) to select it. It is generally selected by default.
4. In the search box, type AIF and press Enter. There are four existing presets to convert your
audio file. For video, the best choice is AIFF 48:16.

5. Grab the AIFF 48:16 setting and drag it into the Task Bar (top window) and drop it on the
file you just imported. (Not in the drop box with the audio file, just anywhere in the Task Bar.)
Once you start compression, by default, it will store your audio file at the same location as the
source file. While this works, I long ago developed an improved workflow.
6. Click the Destination tab to select it. (It's just to the right of the Settings tab.)

7. Click the Plus key to create a new destination for all your compressed files.

8. Then, on your second drive create a new folder called Compressed Files. (Locating this
folder on your second drive is not required, but I find it helpful to always store my media on a
drive other than the boot drive.)
9. Click OK to accept that location.

A new destination, called "Compressed Files" now appears in the Custom folder.

Drag that new destination up to the Task Bar and drop it on top of the existing destination.

So, the steps to compress a file are to:
Import the file into the Task Bar (dragging is the fastest way)
Apply a compression setting
Apply a destination
Make sure your file name is OK, change it if necessary.
Press Submit (the first time) to send the file into compression.
Press Submit a second time to tell your computer it's time to get started.
This is fast, with high-quality, and you already have all the software you need to convert your
audio.
What makes this REALLY efficient, though, is to automate this entire process by creating a
droplet. Then, you can just drop any audio files that you need to convert directly on the droplet
and everything is automatic.
Here's an article that explains how to create a droplet to automate your compression.
UPDATE - DEC. 20, 2010
Mike Jankowski writes:
Larry, as usual your newsletter is wonderful and chock full of fantastic advice.
Thank you... and take some time off for the holidays!
But that audio conversion-via-Compressor bit...ugh! maybe it's simpler if you set
up a droplet and drag the file on it (don't know, haven't tried); but step back and
look at how long it took you to explain that process.
Here's how I do it with QT7:
1) open mp3, aac, etc, in Quicktime (usually by CNTRL clicking
and "Open with")
2) hit Apple-E (export), select AIF or WAV if it isn't already
selected.
3) save the file to the same place as the original
4) when it's done, drag it to where it ought to live.
A WHOLE lot more simpler, no? Not batchable, no, but then I usually run into
compressed files one at a time, so who needs a batch?
Not that I don't like Compressor, it's just too klugey for a simple transcode like
this.
Larry replies: Thanks, Mike, for this technique.
Your system is perfectly fine - as long as you are converting a single file. The batch
processing that droplets provide is worth the extra few steps to setup.
And, as with most things in life, it always takes a lot of steps to explain a simple thing.
[ Go to Top. ]

PASSING THOUGHTS

NEW BOOKS TO READ
Here are three excellent new books to add to your library. Two that I've read and one that I
am looking forward to reading.
The Green Screen Handbook, by Jeff Foster
Sybex Press. ISBN: 978-0470521076
This is an outstanding book for anyone doing green screen work. This covers
everything you need to know from production to post, with an excellent DVD of
examples attached.
Mastering Multicamera Techniques, by Mitch Jacobson
Focal Press. ISBN: 978-0240811765
I spent 20 years directing multicamera shoots, and I still learned a lot from this
book. The demo files on the DVD are beyond outstanding -- multi-camera
performances from Paul McCartney and Elton John. This is a perfect gift for
someone thinking of producing a multi-camera show.
Color Correction Handbook, by Alexis Van Hurkman
Peachpit Press. ISBN: 978-0321713117
Alexis continues his tradition of easily explaining the visual images using words.
From picking the right gear to equipping your suite to making the most of your
software, this book will change how your view, and correct, your images.
NEW ON KENSTONE.NET
1. Final Cut Express and the Middle Child Syndrome, article by Steve Martin.
"The purpose of this article is to give you a complete rundown on the key
differences between Final Cut Express and Final Cut Pro. While Final Cut
Express lacks a lot of the professional features of it's older sibling, it does not
lack any editorial power."
2. Contour HD Camcorder, review by Steve Douglas
"Finally, the day was done, laid back, turned on the Discovery channel. The star
of the show had a tiny little camcorder attached to his helmet. The scene
switched from the main camera to the footage that was shooting from this little
POV cam and I just knew I had to check it out for myself."
3. CalDigit USB3 AV Drive - Review by David A. Saraceno
"CalDigit's AV drive, a Mac compatible SuperSpeed USB3 external hard drive
bundled with either an ExpressCard 34 or PCIe card and a custom Mac driver.
My evaluation package easily installed in an available PCIe slot in a 2009
MacPro. Compatible MacBook Pro owners can purchase the ExpressCard 34
bundle with the drive. The 1TB AV USB3 drive performed surprisingly well using
USB3, and provided the fastest write speeds I've seen for a FW800 device."
4. Red Giant's Magic Bullet Denoiser Review by Steve Douglas
"Low light = video noise, there is no doubt of that. Of course there are many
other factors that contribute to video noise but the entire focus is where to go
from here, when you have footage that simply can't be re-lit or shot. Red Giant,
a company which produces some of the finest plug-ins for both Adobe After
Effects and Final Cut Studio, has recently brought out their own Magic Bullet

Denoiser."
5. Litepanel's Hybrid LED Light - review by Steve Douglas
"Litepanels has been a major player for the introduction and use of LED lights
for on camera video lights. First with their Litepanels Micro, soon to be followed
by its somewhat larger and more durable Litepanels MicroPro, and now, for both
camcorders and still imaging cameras, comes the MicroPro Hybrid."
A COOL FILM
Ricardo Jacques Gale sent me a link to his recent film: Touching Home. Stunning pictures,
take a look.
http://www.ricardogale.com/index_v2.html
[ Go to Top. ]

READER MAIL
To get faster answers to your questions, please visit my Forum, or my Facebook page; both
of which I visit regularly.
Here are some reader highlights from the last month.
QUESTIONS FROM FACEBOOK
Our Facebook page gets flooded with questions - as does our Forum -- and I try to answer
questions in both places. Here are a few highlights:
Brian P asks: I'm confused about this whole backup/archiving business for tapeless media. I
just shot P2 and now have 120 GB of data to backup. How?
Larry replies: Brian, while hard disks are a good place to store media you are
working on, they are not ideal for long-term (longer than 5 years) storage. Bluray Discs are an option, but using them on a Mac can be tricky. My
recommendation is LTO-4 or LTO-5 tape drives.
Here's an article I wrote that talks about these options more.
Sharon LaR asks: What are the duties of an assistant editor?
Larry replies: Sharon, the interesting thing about assistant editors is that they
don't, generally, edit. They are responsible for organizing the work of the editor,
maintaining the equipment, getting files from point A to point B, and keeping
things running smoothly so that the editor can edit.
Two excellent books were released this year that detail what an assistant editor
does.
Make the Cut, by Diana Friedberg and Lori Coleman
Focal Press. ISBN: 978-0240813981
The Film Editing Room Handbook, by Norman Hollyn
Peachpit Press. ISBN: 978-0321679529
I've read both and both are excellent.
Cem Y asks: How do we edit 3D video in FCP?

Larry replies: Using one of three plug-ins from Cineform or Dashwood Cinema
Solutions. The price for these plug-ins ranges from $99 to $2,999. I recently
completed a webinar on the whole process of editing 3D video in Final Cut Pro.
You can learn more about the webinar here.
Also, here's an article I wrote about this recently: Thoughts on Stereoscopic 3D
Video.
Jiri F asks: I want more tips on getting organized and workflow.
Larry replies: Jiri, this is something I've written about a lot. Here are three
articles with more details that you can check out:
* Organizing your Final Cut System
* Organizing and Naming your Files
* Equipping Your Final Cut System
Ahmahallah asks: What plug-ins should we use to output to a on-air play-out server for a
television broadcast?
Larry replies: Ahmahallah, this depends upon your play-out server and what files
it accepts. Many, but not all, accept QuickTime movies, which can be exported
directly from Final Cut Pro.
Others require H.264 files with high bit rates, which can be exported using File >
QuickTime Conversion.
Still others prefer other formats, which Final Cut Pro does not natively support.
Two utilities that may help are:
Flip4Mac, from Telestream
MXF4Mac from Hamburg Pro Media.
Enda G asks: What is the correct encoding for TV?
Larry replies: This totally depends upon the requirements of the broadcast
station. Smaller markets are still working with SD and DigiBeta. All networks are
exclusively HD, however some require 1080i material, while others require 720p.
Some accept files, while others expect final delivery on HDCAM tape.
What you need to do before you start any project is to find out PRECISELY what
deliverable format you need to create. Nothing is worse than getting to the end of
a project and discovering that you did it in the wrong format.
Also, don't assume the producers know what they want. Have them, or yourself,
contact the broadcast outlet directly and get a written description of what you
need to deliver.
Glenn asks: What is the best way to encode for YouTube or a department webpage?
Larry replies: Glenn, these are not the same. A very easy way to encode for
YouTube is to use the YouTube option built into Final Cut Pro 7.

To select it, choose File > Share. Final Cut will export and compress a version
specifically for YouTube and, if you provide your login information, it will
automatically transfer the compressed file to your YouTube account.
For video posted to the web, this depends upon what your website requirements
are. For simple QuickTime movies, I like encoding using the iPad and iPhone 4
setting in either Compressor or Share.
For Flash movies, you'll need to purchase third-party software for the
compression. While it is possible to fool Flash into playing an H.264 file by
changing the file extension, it is better to use software specifically for creating
Flash movies using a range of codecs and settings.
UPDATE - DEC. 22, 2010
Al Davis sent this:
In your most recent newsletter, you reference how to encode for
Flash.
"For Flash movies, you'll need to purchase third-party
software for the compression. While it is possible to
fool Flash into playing an H.264 file by changing the
file extension, it is better to use software specifically
for creating Flash movies using a range of codecs
and settings."
This is not my experience at all. Initially, I thought I was the last
person in the field that got it; in terms of how successful you can
be with embedding H.264 content into Flash. Prior to that I was
really encouraged by ON2 VP6 codec; but could not understand
while other offerings still looked superior. Then I got it!
H.264 with a Flash wrapper. (Apple essentially did the same thing
with QuickTime - embracing H.264 as the codec of choice). I no
longer encode for web with Quicktime Player; only because Flash
is so superior as a cross-platform media. (No PC complainers!!) At
1st I did as you suggested, and changed the .mov to .flv. NOT
NECESSARY! I now work with one of the many Flash players that
you can download and purchase. Encode with fantastic results in
H.264; and attach the player. Voila.

Attached is a link to see as an example.
http://www.visualvelocity.com/brookline_soccer_tutorials/10_min_wu/videoPlayer.html
This one is even better (my medical work that I shoot and edit) WARNING SURGICAL SCENES (artfully done) ;-)
http://visualvelocity.com/visual_velocity_o_r/vv_reel/videoPlayer.html
Larry replies: Al, thanks for the update!
Dave E asks: What can you tell me about PluralEyes?
Larry replies: A great deal. Take a look at this technique/review that I wrote.
Piotr K asks: What is the best FCP sequence setting to use for a slide montage of JPEG
images?
Larry replies: Final Cut Pro is designed for creating video. If you simply want
moves on stills, without turning them into video, using iPhoto or other image
animation software will yield far smaller files.
However, if you need to create video, a really good codec would be either
Animation or ProRes 422. (You need to create a custom Audio/Video Setting to
use either one of these.) Then, after you export the file, compress it into H.264.
Both Animation and ProRes support extremely high image quality. ProRes has
the edge if your system supports it, but both are good.
LOCKING A QUICKTIME MOVIE
William Aleman sent this:
I'm happy to share that I have found the feature I was looking for to lock
QuickTime movies from being downloaded or saved by the visitors on the
Internet. I was looking for this solution because I had posted a QuickTime
movies, blocked it for downloads and a friend of mine was able to use the "Save
As" feature and download it anyway.
The features consists in using AppleScript Editor to write the commands inside
the video clip file, Instead of depending in the use of HTML or XML syntax like
<"KIOSKMODE="True"> among other types, which do not offer as much
protection as the script method does.
The target command is "Save as Un-editable". After setting this savable property
to false, the original movie is exported as a self-contained movie. Out of respect
to the authors of the book I'm not displaying the content of the AppleScript
command but anyone interesting on the subject can find extended information in
the book "QuickTime for the Web" For Windows and Macintosh, third edition,
2007, published by Apple. The included CD that comes with the book, also
provides about 100 scripted droplet files for QuickTime. The book also describes
other tricky methods to protect the QT movies in general.
In addition to internet file copy protection, the video clip can not be copied,
saved or modified after it has been scripted unless the user has a special tools
to un-lock the commands. So, anybody using this feature should always apply
this commands to a copy of the original file, otherwise the original can not be
saved or altered in any way.

Of course, today anyone can use a screens hot software to copy the content of
a video clip, but at least this will stop the honest users, as the authors of the
book called them.
Larry replies: William, thanks for sharing this.
TWO AUDIO QUESTIONS
L. Blake Baldwin asks two audio questions:
1. Why does the Master Gain default to .51 in Final Cut's File > Log and
Capture > Settings tab? Is that the proper setting?
2. Under what circumstances do you use a +3 dB audio transition instead of a 0
dB audio transition?
Larry replies: Blake, good questions.
About your first question, on my system, Master Gain defaults to 1.0. The 0.51 value does not
strike me as a correct setting. This could be caused by accidentally changing the master gain
in the audio mixer (Tools > Audio Mixer), or corrupted preference files. Trashing your Final
Cut Pro preferences should reset this setting to the correct value.

Regarding your second question, audio gain is not linear, it's logarithmic. This means that
when you do a straight linear fade between two audio clips, there will be a slight fade -- of
about 3 dB in the middle of the transition. This linear fade is called an "equal power"
transition. (I've illustrated it below using a screen shot from Soundtrack Pro, which shows the
shapes of the two fades that Final Cut Pro supports.)

To fix that audio dip during the transition, we can add 3 dB of gain to the middle of the effect,
thus canceling out the audio dip. This logarithmic fade is called an "equal gain" transition.
In general, use the 0 dB transition when fading to or from black. Use the +3 dB transition
when fading between two audio clips. The +3 dB fade is the default setting for Final Cut.
CONVERTING 4:3 TO 16:9

Randy White asks:
I have a TV program that is 4x3 and now I have a station that wants it in the
16x9 format. How do I upsize my original 4x3 video to 16x9?
Larry replies: The easiest way is using Final Cut, though Compressor is also an option.
Simply drop your finished 4:3 sequence into a 16:9 timeline using the same codec and reexport.
You'll get black bars on the sides of your image, but your images will be intact, without
cropping.
If you need to fill the frame, you'll need to crop a portion of your image at the top and the
bottom to get it to fit properly; plus the image will look a little grainy and blurry. Because you
are cropping the image, you also run the risk of losing something essential in the image.
I'd suggest going with the black edges to preserve your image.
A DIFFERING OPINION ON EXPORTING
Alexander Kallas takes exception to something I wrote:
Larry, in your article -- Exporting From Final Cut Pro for a DVD -- you write:
Using Compressor always takes longer than real-time. And, with
one exception, yields the same quality as exporting as a
QuickTime movie. Based on what I have been told, the benefit of
going directly to Compressor is that if you have created a Motion
project using 32-bit float space for your calculations, your Motion
projects will look slighting better when you go directly into
compression without first exporting.
However, if you create your Motion projects using the same video
codec as your Final Cut project, you don't get this benefit.
I beg to differ. If you have graphics or effects created in Motion, then you are
better off exporting a self-contained QT movie for Compressor.
Compressor ignores the FCP sequence settings and converts the raw data from
the [Motion project] directly to the format you have chosen in Compressor.
Problems with pixel aspect ratios can occur when the sequence contains
computer generated graphics or titles. Looking forward to your thoughts.
Larry replies: While you are correct, prior to Final Cut 7 I never found the improvement in
quality to be worth all the extra time it took to export and compress the file.
The rules changed, however, with Final Cut 7. Now, Sending to Compressor is a background
activity, which means that your system is not tied up during the export.
If you have a Final Cut Pro project that contains Motion projects, especially Motion projects
created using gradients and blend modes, this option is worth exploring.
TARGETING TRACKS
Sebastian Guest asks:
Is it possible to use the keyboard to target audio tracks with a track number
higher than 9?

Larry replies: No.
For tracks 1 - 9, there is a keyboard shortcut, but not higher numbered tracks.
Video: F5 followed by (NOT at the same time as) the track number.
Audio 1: F6 followed by the track number
Audio 2: F7 followed by the track number.
Shift+F5 or F5+0 disconnects the video patch
Shift+F6 or F6+0 disconnects the a1 patch
Shift+F7 or F7+0 disconnects the a2 patch
TRANSITION TRICK
Richard Day sent this in:
FCP will set your transition to 1 frame if you don't have handles on both clips. I
wanted to start a transition at the very beginning of the second clip, but the
Transition Editor would not let me select the left-most alignment button, even
though I had enough frames on the first clip.
I temporarily set up a dummy edit (to Slug) elsewhere using the left-most
transition alignment button, the copied the transition and pasted it at my original
edit point -- it worked!
Larry replies: Thanks! You can also accomplish this by dragging a transition from the Effects
tab in the Browser. Or, by Option+dragging a transition from another edit point, which makes
a copy of the transition as you drag.
To change the timing of a transition, select it and type:
* Option+1 to start it at the edit point
* Option+2 to center it at the edit point
* Option+3 to end it at the edit point
TRACKING DOWN A RENDER FILE
Richard Day writes:
I've searched for answers in many places, so you're kind of a last resort.
I rendered a sequence (10 hours! - Neat Video noise remover) and the following
happened:
-- I was told I was out of disk space and could I free some up by removing
render files
-- but there was TONS of extra space on my external render file drive (750 GB)
, but my *startup disk* was nearly full now
-- the startup drive was not listed, even as an alternate, in System Settings
So my questions are:
1) Does FCP store render files (invisibly/as temp files) on the startup disk, then
transfer them to the render file disk?
2) Is there a way to "Reveal in finder" render files located in the Render
Manager? Control-click did not help.

Larry replies: First, there are no hidden render files, nor are they stored on one disk then
copied to another.
My guess is that this was caused by corrupted FCP preference files -- delete those and your
problem should go away.
Here's an article that explains how: Trouble-Shooting Your Final Cut System
Note: As a postscript, Richard sent me a second email saying this fixed the
problem.
FIXING A PROBLEM WITH CANON 5D IMAGES
Rick LeCompte sent this in:
I was working with some 1920 x 1080, Pro Res 442, 23.98 footage shot on the
Canon 5D, and I'm comping some green screen shots. Everything looks OK as I
set it up, but when I render the shot it ends up with thin vertical lines visible.
The lines are not just over the green screen areas but over the foreground
talent. I had never seen this before.
Then, I solved this problem. I originally set the key up with Color Smoothing
4:2:2 and Chroma Keyer. It turned out that by removing the Color Smoothing
4:2:2 filter from the key, the lines went away. Something in the 5D doesn't work
with the color smoothing because I had the lines return with Color Smoothing
4:1:1 also. Anyway, it's fixed, and thought you might be interested.
[To give credit where credit is due, I should mention that my assistant, Jesse
Kerman, did the dirty work experimenting with the clips.]
Larry replies: Cool, thanks for letting me know.
A SIMPLE QUESTION
Andy Roberts asks:
Larry, I'm using FCP 6 on a Mac. Simple question: I'm trying to edit some
footage that I grabbed off a DVD. What is the fastest way to delete curse words
from audio. I'm used to working in Logic and simple editors like Fission where I
can simply select audio and press delete. I'm working with one large file from the
DVD (MacTheRipper and MPEG StreamClip) and I can't seem to see the audio
waveforms in the section I am in and key-framing seems a bit cumbersome to
remove single words here and there. Of course I want to keep the files in sync.
Larry replies: Andy, thanks for writing!
Command+Option+W toggles waveforms on and off in the Timeline.
Use the Blade tool (B) to cut before and after the words you want to delete.
Select the portion of the clip you want to delete and press Delete.
IMPROVING EXPORT IMAGE QUALITY
Brian Pshyk asks:
I have a quick question on export quality. Why is it that when I export my
sequence as a mov that the quality of the QuickTime is soft. My sequence
settings are 720x480 DVCpro50 compression. I export with the "same as

sequence" settings not going higher, but not compressing more and I still cannot
get the sharpness like I have in the canvas window. Is this something I just have
to accept? Can it be a problem with the quality of my computer monitors?
Larry replies: Hmmm... I know I have an article about that here somewhere.... (rustle, rustle).
Here you go, read this: http://www.larryjordan.biz/articles/lj_dv_look_bad.html
To fix it, open your movie in QuickTime 7. (QuickTime X doesn't have this ability. QT 7 is in
the Extras folder of your OS X 10.6 installation disks.)

Go to Window > Project Properties
Select the Video track
Select Visual Settings tab
Turn ON High Quality
Turn ON Single Field
Done.
PICKING THE RIGHT CODEC
Douglas Steick asks:
I enjoyed your Soundtrack Pro & Motion training on Monday and did get some
workflow issues resolved, however I did not ask this:
Scenario:
First, I crop, resize, and clean-up various video formats (mostly infrared imagery
from sensors, ranging from 1288 1024 to 5K 5K) with After Effects to 1920
1080.mov files.

Second, these .mov files are run through Motion to add various text treatments
and then sent to Compressor to create the "final" .mov files.
Third, these "final" .mov files are imported into FCP.
Goal is to deliver the best image quality possible for delivery as an interactive
Blu-ray Disc.
With this workflow I have used the Apple ProRes 422 (HQ) codec for all steps.
While reading your "Picking the "Right Version of ProRes" article, I was
particularly interested in the statement: "We use the Animation codec when we
want to move files between one application and another, for example, between
After Effects and Final Cut. Then once it's in Final Cut, you render it into the final
version you need for your project.
Question:
Should I be using the Animation codec out of both After Effects and Motion, and
importing those files into Final Cut with it's project settings set to Apple ProRes
422 (HQ) and decline the offer for Final Cut to reset the project settings when
the Animation file lands on the timeline? Or should FCP be set to the Animation
codec? Then send to Compressor for the H.264 (I am actually using the x.264
codec) for Blu-ray authoring?
Larry replies: Doug, great question. The short answer is no.
Here's a medium answer.
The Animation codec is for FCP 6 and earlier. For FCP 7, you should be using ProRes 4444,
which is virtually lossless and higher quality than Animation.
Here's a longer answer:
When exporting your files from After Effects, export them as ProRes 4444 - highest quality,
can include alpha channel data, greater bit depth than most other video formats. Only
downside is large file size.
Bring those files into Motion and do your processing. Since you've already scaled and
converted them in After Effects, there is no benefit to exporting them from Motion. Just save
the Motion file -- very small and VERY fast -- and import that into Final Cut for final editing.
When you are done editing, export as a self-contained movie and compress that to H.264 in
Compressor. This should be much faster and retain more quality -- especially in the shadow
areas of your image.
A QUESTION ON TIMECODE
Sebastian asks:
I'm delivering an 88min feature, for which we have a number of deliverables 23.98NDF, and 59.94DF. The project has been posted at 23.98NDF, when we
play the feature out to tape at 59.94DF, the out point on the tape's TC is ~5sec
later. This poses the question - will our feature (at 88mins on NDF) cause issues
with a station if we give them a DF tape that clicks out at 88m and 5s? How do
things usually work when there are multiple deliverable types and one prespecified duration?
Larry replies: The reason that drop frame timecode was invented was because non-drop did
not properly indicate running time.
As you have discovered, there is a difference in running time between DF and NDF material.

The DF is correct, the NDF is not.
So, if you need to deliver something for broadcast, you will need to use drop-frame timecode.
If your movie needs to have an exact running time of 88 minutes, then you will need to switch
to drop-frame timecode AND cut five more seconds.
The CONTENT is identical between DF and NDF. The TIMING is not.
CREATING A STEREOSCOPIC 3D EFFECT IN MOTION
Pieter asks:

After seeing your Webinar about Stereoscopic 3D I came up with the following
thoughts. If I load footage in Motion and make two different clips with different
camera points of view ( left and right). Will this work?
Larry replies: Maybe. What makes 3D work is that different elements in your shot align
differently when viewed from slightly different horizontal angles; about 63 cm.
If all your objects are at the same depth, this won't work.
If you objects are spread out in depth, it may work.
The problem is, there's no way to combine these two cameras in Motion in real-time so that
you can adjust your elements for best effect. In other words, this will be a very timeconsuming way to create a stereoscopic 3D image due to needing to use FCP for your
preview system.
THE WORLD-FAMOUS UNKNOWN THINGY
Jarko Romanesko asks:

Can you perhaps tell me what the "color spiral button" is for and what the proper
name is?
Larry replies: I've been waiting and waiting for someone to ask me this question!

Yes! This button determines the direction colors will rotate around the color wheel when you
have applied keyframes to change the color of something.
For example, the left image illustrates color roation going from red to green to blue or, on the
right, from red to blue to green.
I call it the Color Thingy.
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WRAP-UP
Well, that's it for this issue. Feel free to use my Forum for more questions, I always enjoy
talking with you. And, this way, we can all learn from each other.
For current news and in-depth interviews on what's happening in our industry, be sure to
listen to the Digital Production BuZZ every week.
Also, please consider supporting this newsletter by:
Downloading one of my in-depth webinars.
Buying a tutorial - decrease your stress and get back to work.
Or, buy a mouse pad -- you know you need a new one...
Also, please continue sending me your comments and questions. I love hearing from you and
enjoy the conversations that develop around your comments.
Until next month, take care, and edit well.

Larry
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